
WELCOME TO REVEILLE !!!

First, the necessary legal statements:

Reveille (V. 1.0) Copyright 1993 by Frederick Wasti.  All rights are reserved.

FREDERICK WASTI DISCLAIMS ALL WARRANTIES RELATING TO THIS SOFTWARE, 
WHETHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, AND
ALL SUCH WARRANTIES ARE EXPRESSLY AND SPECIFICALLY DISCLAIMED.  
FREDERICK WASTI SHALL NOT BE LIABLE FOR ANY INDIRECT, CONSEQUENTIAL, OR 
INCIDENTAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE SUCH 
SOFTWARE EVEN IF FREDERICK WASTI HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES OR CLAIMS.  IN NO EVENT SHALL FREDERICK WASTI'S LIABILITY FOR 
DAMAGES EVER EXCEED THE PRICE PAID FOR THE LICENSE TO USE THE SOFTWARE, 
REGARDLESS OF THE FORM OF THE CLAIM.  THE PERSON USING THE SOFTWARE 
BEARS ALL RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE.

This agreement shall be governed by the laws of the Commonwealth of Massachusetts 
and shall inure to the benefit of Frederick Wasti, and any successors, administrators, 
heirs, and assigns.  Any action or proceeding brought by either party against the other 
arising out of or related to this agreement shall be brought only in a state or federal court 
of competent jurisdiction located in the Commonwealth of Massachusetts.  The parties 
hereby consent to in personam jurisdiction of said courts.

This software and the disk on which it is obtained is licensed to an individual or institution
user, for his/her/its own use.  This is copyrighted software.  The user is not obtaining title 
to the software or any copyright rights.  The user may not sublicense, rent, lease, convey, 
modify, translate, convert to another programming language, decompile, or disassemble 
the software for any purpose.  The user may make one copy of the software for back-up 
purposes.  The user may use this software on his/her/its own computer(s) only.

For information, please contact:

       Frederick A. Wasti
       Post Office Box 274
       No. Carver, MA 02355

REVEILLE OVERVIEW

Welcome to Reveille !!!  Reveille is a program that will play musical tunes, either on 
demand while it is running, or at start-up using command line parameters sent it by a 
separate timer or scheduler application.  If you wish, you may specify a reminder message
in the command line that starts the program, and Reveille will display it in the Status Label
at the bottom of the Reveille window.  The tunes are stored in simple ASCII text files that 
emulate BASIC "play" strings.  You may create and/or edit tune files (in the Reveille ".ply" 
format) from within Reveille (or using any plain-ASCII text editor), and you may compile 
and save groups of tunes as compilation files.  

The "shareware" version of Reveille is being distributed both on diskette and as a 
"zipped" file over bulletin board systems.  The registered version is available by mail 
directly from Reveille's author (who will also upload additional Reveille tune files to BBSs, 
and who hopes other Reveille users will do the same).

Please note:  This documentation file is for use with the unregistered version of Reveille, 
distributed as "shareware", for evaluation purposes only.  You are entitled to install 



Reveille on one computer, and to "test-drive" the program for a 30-day trial period.  If you 
wish to give Reveille a more permanent home on your computer's hard disk, then you 
must register your use of Reveille.  You would then be entitled to a copy of the latest 
version of the program (without any "reminder screen"), additional ".ply" files, and more 
complete documentation.  Please see the section on REGISTRATION near the end of this 
file, as well as the file, register.wri.  Thank you for trying out Reveille !!!

INSTALLATION

Note:  Since Reveille is written in Visual Basic V. 3.0, the VB 3.0 dynamic link library file, 
vbrun300.dll, must be available on your computer for the program to run.  If you don't 
already have vbrun300.dll installed on your machine (for running some other VB 3.0 
program), then you will have to obtain a copy of it;  you can probably download it from the 
same BBS from which you obtained rvle-10.zip.

To install Reveille (and Reveille Timer), simply copy all of the files (except vbrun300.dll) 
over to any directory of your choosing (such as c:\reveille, perhaps).  And, unless you 
have a copy of vbrun300.dll in your Windows System directory (typically c:\windows\
system) already, you should copy it over to there, so that it will be available to any 
program installed on your computer written in Visual Basic V. 3.0 (although it also may be 
placed directly in Reveille's directory, if you prefer).  Run Reveille from reveille.exe, and 
Reveille Timer from rvletimr.exe, either from File Manager, or by adding their icons to 
Program Manager.

COMMAND BUTTONS

The Play command will cause Reveille to play the tune(s) in the Selected Tunes List for the
number of times selected in the Play Time(s) box.  You may invoke the Play command by 
clicking on the Play button (or menu item), or by using either the Alt+P or Ctrl+P key 
combination.

The Stop command will cause Reveille to cease playing the tune(s) in the Selected Tunes 
List.  You may invoke the Stop command by clicking on the Stop button (or menu item), or 
by using either the Alt+S or Ctrl+S key combination.

The Add File command will add a file selected from the Files List to the end of the Selected
Tunes List;  note that you must first select the file before clicking on the Add button (or 
Add File menu item).  It is also possible to double-click directly on the chosen file to add it 
to the Selected Tunes List.  You also may invoke the Add File command with the Alt+A key 
combination.

The Insert File command will insert a file selected from the Files List into the Selected 
Tunes List;  note that you must first select both the file to insert and the insertion point 
(the file before which it is to be inserted) before clicking on the Insert button (or Insert File 
menu item).  You also may invoke the Insert File command with the Alt+I key combination.

The Edit File command will start up Windows Notepad, loaded with a file selected from the 
Files List, in order to edit (or merely view) the file;  note that you must first select the file 
before clicking on the Edit button (or Edit File menu item).  To test any changes made in 
the file, it is necessary that the file be saved by Notepad (with a ".ply" extension on the 
filename) and be present in the Selected Tunes List.  Reveille will not open a second tune 
file while the first file is still open.  You also may invoke the Edit File command with the 
Alt+E key combination.

The Remove File command will remove a selected file from the Selected Tunes List;  note 
that you must first select the file before clicking on the Remove button (or Remove File 



menu item).  It is also possible to double-click directly on the chosen file to remove it from 
the Selected Tunes List.  You also may invoke the Remove File command with the Alt+R 
key combination.

The Clear List command will clear (remove) the files present in the Selected Tunes List.  
Note that you will remove all files currently in the List (whether selected or not) by clicking
on the Clear button (or Clear List menu item).  You also may invoke the Clear List 
command with the Alt+C key combination.

The Restore List command will replace the current Selected Tunes List contents with the 
List that was originally present when Reveille was started.  Clicking on the Restore button 
(or Restore List menu item) will clear (remove) all files in the Selected Tunes List, whether 
selected or not, before replacing them with the original Selected Tunes List.  You also may 
invoke the Restore List command with the Alt+T key combination.

The Compile List command will combine the tunes present in the Selected Tunes List into 
one ".ply" tune file (without changing the original tune files).  This Reveille feature is most 
useful for playing more than one tune from the start-up command line.  Clicking on the 
Compile button (or Compile List menu item) will bring up dialog boxes for the entry of both
a compilation title and a filename.  You also may invoke the Compile List command with 
the Alt+O key combination.  

The Save List command will save the current Selected Tunes List.  Clicking on the Save 
button (or Save List menu item) will cause Reveille to start up the next time with the 
current List loaded as the Selected Tunes List, unless the Selected Tunes List is 
overridden with a command line parameter (and the saved List may still be restored with 
the Restore List command even then).  You also may invoke the Save List command with 
the Alt+V key combination.

The Exit command will cause Reveille to cease playing the tune(s) in the Selected Tunes 
List, and to then close itself.  You may invoke the Exit command by clicking on the Exit 
button (or menu item), or by using either the Alt+X or Ctrl+X key combination.

OTHER WINDOW FEATURES

The Selected Tunes List will display the names (and DOS paths) of the tunes that are to be 
played by Reveille.  You may add a tune file to the List by first selecting it in the Files List 
and then clicking on the Add button, or you may add it directly by simply double-clicking 
on its filename in the Files List.  You may remove a tune from the List by first selecting it 
and then clicking on the Remove button, or you may remove it directly by simply double-
clicking on its filename in the Selected Tunes List.  You may empty the List of all tune files 
by clicking on the Clear button, or you may reinstate the original saved Selected Tunes 
List at any time by clicking on the Restore button.  You may save the Selected Tunes List 
for the next start-up by clicking on the Save button, or you may compile the List into a 
single ".ply" file by clicking on the Compile button.

There is practically no limit to the number of tunes that may be added to the Selected 
Tunes List, but the total length of the combined tune string to be played is 10922 bytes, the
size of a buffer into which the tune string is to be loaded.  This is a fairly generous limit, 
however, and will not likely be reached often (as 10922 bytes will contain a lot of music).  
Furthermore, this limit applies only to the List itself, and does not prevent even a large List
from being played multiple times.  By the way, the size of a combined tune string is 
approximately the combined file sizes of the individual ".ply" files in the Selected Tunes 
List, so that it is possible to roughly estimate the combined tune string's size by adding all
the file sizes together (which File Manager will do for you if you temporarily select them as
a group from within File Manager).  If the total does exceed 10922 bytes, Reveille will not 



play the List, and will inform you of the total tune string size in the Status Label at the 
bottom of the Reveille window, so that you can estimate how many files to remove from 
the List.  Since this limit also applies to the size of a compilation file, I suggest that when 
you are going to either save or compile the files in the Selected Tunes List that you at least
briefly attempt to play them first.

The Drive List Box will allow you to select any drive available on your computer, in order 
to then select a particular directory (in the Directory List Box) from that drive, from which 
to select a particular tune file.  The Files List will display all the ".ply" files available in the 
directory selected in the Directory List Box.  You may update the Files List at any time (in 
the event that files may have been added to it or deleted from it since Reveille was first 
started) by clicking once on the current directory in the Directory List Box.  Although 
Reveille is set up at first with all tune files located in the same directory as reveille.exe, it 
is very possible to create individual, "topical" subdirectories for groups of related ".ply" 
files using File Manager.

The Status Label at the bottom of the Reveille window will provide feedback from Reveille 
at various times (though message boxes will also be used at other times), as well as 
displaying any reminder message entered from the command line.  Clicking on the Status 
Label at any time will display the last Help screen viewed.

The Play Times Box will allow you to select a number of times (one, three, or nine) that you
wish to play the Selected Tunes List, or you may choose to play the List for an indefinite 
time period.

The File Menu allows access to the same commands available in the Reveille window, 
while the Help Menu allows you to obtain Help on both command functions and command 
line parameters.

MOUSE CLICK FUNCTIONS

Besides the usual Windows mouse click functions, Reveille will recognize the following 
additional mouse actions:

1.  Double-clicking with the mouse on a file in the Files List will add that file directly to the 
end of the Selected Tunes List, without actually having to click on the Add File button (or 
menu item).

2.  Double-clicking on a file in the Selected Tunes List will remove that file from the List, 
without actually having to click on the Remove File button (or menu item).

3.  You may update the Files List at any time (in the event that files may have been added 
to it or deleted from it since Reveille was first started) by clicking once on the current 
directory in the Directory List Box.

4.  Clicking with the right mouse button on any command button will display Help 
information about that button's function.

5.  Clicking on the Status Label at the bottom of the Reveille window will cause the last 
Help topic viewed to be displayed again.

COMMAND LINE PARAMETERS

The Reveille command line syntax is as follows:

" reveille <conditions> <filename> <message> "  (Do not include the parentheses.)



1.  The conditions, filename, and message are all optional, though if you use a filename, 
then at least one condition must precede it, and if you specify a message, then at least one
condition and a filename (or asterisk) must both precede it.

2.  Command line entries are not case-sensitive (except that you should type the message 
exactly the way you want it to appear).

2.  Single spaces should be used to separate parts of the command line from each other.

3.  You may enter reveille.exe either as "reveille" or as "reveille.exe".  Similarly, you may 
specify a filename either with or without the ".ply" extension.

These optional conditions may be specified in the command line used to start Reveille:

       m  =  start Reveille as a Minimized icon
       n   =  play Now, as soon as Reveille starts up
       1   =  play the Selected Tunes List 1 time
       3   =  play the Selected Tunes List 3 times
       9   =  play the Selected Tunes List 9 times
       i    =  play the Selected Tunes List Indefinitely
       x   =  eXit Reveille after play has stopped
       r    =  play "Reveille" as Reveille starts up
       d_ =  play for a Duration of _ minutes and exit

You may specify multiple conditions in any order, but there should be no spaces between 
multiple conditions.  If you specify the "r" condition, then the "n" condition becomes 
redundant.  If you specify the "d_" condition, then most other conditions entered (except 
for the "m" or "r" conditions) will be ignored.  The duration condition is limited to 32000 
minutes (which is not too limiting, since that is over three weeks in time);  if you attempt to
enter a longer duration (such as "d123456789", for example, it will be changed to 32000 
automatically.  By the way, do not use commas when (if?) you enter long (over 999 
minutes) durations.

You may specify an optional ".ply" tune filename in the Reveille command line (if at least 
one condition has been specified before it) and it will then be the tune displayed in the 
Selected Tunes List as Reveille starts, and it also will be played at start-up if the "n" 
condition has been specified.  The ".ply" extension in the filename is optional.  If the 
filename you specify is not in the same directory as Reveille, then you must state the full 
path to the file for the filename.  If you enter an asterisk for the filename, then the saved 
Selected Tunes List will be played (assuming that you have also used the "n" condition). 

You may specify a reminder message as part of the command line used to start Reveille, 
and it will then be displayed in the Status Label at the bottom of the Reveille window.

1.  In order to display a reminder message, at least one condition parameter and the name 
of a ".ply" file (or an asterisk) must precede it in the command line (separated from it by a 
space).

2.  If you have specified a message, then the "m" parameter condition (if used) will be 
ignored, in order that Reveille will display the message in the Status Label when it starts 
up.

3.  You may turn off the message display after Reveille starts up by "unchecking" the 
Message menu item;  you may later turn it on by "checking" the Message menu item once 
again.



4.  Reveille's window title bar will indicate "Reveille Reminder" while a message is being 
displayed, and will simply show "Reveille" when one is not.

Some examples of Reveille command line usage follow:  (Do not include any parentheses.)

1.  " reveille " will start up Reveille, without playing any tune or displaying any message.

2.  " reveille nm3x wmtell " will start Reveille as a minimized icon, playing the "William Tell 
Overture" three times before exiting;  note that the characters in "nm3x" may be entered in
any order.

3.  " reveille d2 * Don't forget your appointment !!! " will start Reveille, playing the Selected
Tunes List repeatedly and displaying this reminder message continuously, until exiting at 
the end of two minutes.

4.  " reveille d10r * Stop at the store on the way home !!! " will start up Reveille, playing the
tune "Reveille" repeatedly and displaying this reminder message continuously, until 
exiting at the end of ten minutes.

ACCESSING HELP

There are several ways to obtain Help information on Reveille commands and features:  
You may access Help on any topic through the Help Menu.  Press the F1 key while any 
command button has the focus, or click with the right mouse button on any command 
button, and you will cause Help information on that button's function to be displayed.  If 
you click on the Status Label at the bottom of the Reveille window, you will cause the last 
Help topic viewed to be displayed again.

FILE FORMAT

(Please note:  It is not necessary to understand the structure of a Reveille ".ply" file in 
order to use Reveille with the supplied tune files, but if you ever wish to create or modify 
any ".ply" files, or to import any BASIC "play" files, then you do have to understand the 
format, in order to provide tune files that are usable by Reveille.)

A Reveille ".ply" file must have three parts:  the title of the tune, followed by three 
asterisks, followed by the actual tune string.  The title, which will show up in the Selected 
Tunes List, must not include either commas or parentheses, but may include most other 
normal punctuation;  you may use brackets in place of parentheses, if desired.  Three 
asterisks ( *** ) must be used to separate the title from the tune string in the ".ply" file, and 
should not be preceded by any spaces after the title.  The filename must also be given a 
".ply" extension to be recognized by Reveille.

The tune string is an ASCII string of characters that emulates the "play" string format used
in DOS BASIC, and for those who are familiar with that, the Reveille tune string format will 
also seem quite familiar.  In fact, it is easy to import a BASIC tune string, converting it to a 
Reveille ".ply" file, with only minor modifications.  A full description of the Reveille tune 
string format, as well as strategies on creating, editing, and converting tune strings, is 
included in the registered version of the Reveille documentation.

To help with editing (or debugging) a tune file, pairs of brackets may be used temporarily 
to select out portions of a tune string for play (or to exclude other portions from play).  If 
this is done, only the tune string segments within pairs of brackets will be played, while 
segments outside the brackets will be ignored, allowing you to focus on just certain 
sections of a tune string for editing.  (If the beginning of a tune string includes a series of 



default settings for tempo, octave, duration, and style, such as "T180mnL4o3", then they 
should also be included in their own pair of brackets, or else they will be ignored.)  In each
case, a left bracket signals the start of a segment to be played, while a right bracket 
signals its end.  Inserting a pair of brackets into a tune file automatically turns on this 
editing feature;  however, upon the completion of editing, all the brackets should be 
removed, as Reveille only allows one tune in the Selected Tunes List to be played if any 
editing brackets are used.

It is quite possible to import BASIC "play" tunes, converting them into Reveille ".ply" 
format, and several such tunes are available on bulletin board systems.  Usually, only a 
little bit of editing is needed to make the conversion (after the title and three asterisks are 
added, of course).  Conversely, Reveille ".ply" files may be used in DOS BASIC by 
stripping the title and asterisks, and then possibly doing a little editing of the remaining 
tune string, although (obviously!) I am hoping that most conversions will be in the 
direction of DOS BASIC to Windows Reveille.

SOUND DRIVER CONFLICTS

Reveille uses the Windows sound driver to generate its musical notes (as does the 
computer's own "beep", as well as any program that plays ".wav" files), and this driver 
(sound.drv, located in the Windows\System directory) is somewhat "finicky" about two 
programs trying to access it at one time.  Since it is possible that the timer or scheduler 
that you use may "want" a second copy of Reveille to start while a first copy is still 
running, a "full" second copy of Reveille will not start up (to avoid sound driver conflicts); 
instead, a message box will be displayed, displaying the reminder message, so that the 
second message will still not be lost.

Because of possible sound driver conflicts, I suggest that you do not play any ".wav" file 
at the same time that Reveille is running, as the results may be unpredictable.  However, 
unless you are using a separate sound card to play the ".wav" files, you may find that the 
rest of your computer's functions seem to be "frozen" while ".wav" files are being played, 
so that a timer that is "trying" to start Reveille at a time that a ".wav" file is being played 
may be forced to wait until just after the ".wav" file is through, thereby avoiding any sound
driver conflict.

REGISTRATION

This documentation file is for use with an unregistered copy of Reveille, distributed as 
"shareware", for evaluation purposes only.  You are entitled to install Reveille on one 
computer, and to "test-drive" the program for a 30-day trial period.  If you wish to give 
Reveille a more permanent home on your computer's hard disk, then please consider 
registering your use of Reveille.  You would then be provided with a copy of the latest 
version of the program (without any "reminder screen"), some additional ".ply" files, and 
more complete documentation.

INDIVIDUAL USER REGISTRATION

Registration fees for Individual Licenses are as follows: Separately, Reveille may be 
registered for $12.95 (plus $5.00 shipping and handling);  Reveille Timer may be registered
for $9.95 (plus $5.00 s&h).   Or, the two programs may be registered together for $19.95 
(plus $5.00 s&h).  You may use the registration form at the end of the register.wri 
document (or you may simply print out the separate orderfrm.txt document);  if you prefer, 
you may provide all of the registration information in a separate letter.

An Individual License for either Reveille or Reveille Timer entitles the registered user to 
install that program on any computer(s) that he/she personally owns, but he/she must NOT



allow his/her registered copy of that program to be installed or used on any other 
computer(s).

SITE LICENSE REGISTRATION

A Site License for either Reveille or Reveille Timer entitles the registered institution 
(school building, business location, organization headquarters, etc.) to install that 
program on any computer(s) belonging to that institution at that particular location, but 
registered copies of that program may NOT be distributed beyond the boundaries of that 
particular location.  Furthermore, a copy of Reveille or Reveille Timer that is registered to 
an individual user may be installed on his/her own computer at an institution, but that 
individually licensed copy of Reveille or Reveille Timer may NOT be be installed on any 
other computer(s) at that institution (for this a Site License would be required).

Registration fees for Site Licenses are as follows:  Separately, Reveille may be registered 
for $49.95 (plus $5.00 shipping and handling);  Reveille Timer may be registered for $29.95 
(plus $5.00 s&h).   Or, the two programs may be registered together for $59.95 (plus $5.00 
s&h).  You may use the registration form at the end of this document (or you may simply 
print out the separate orderfrm.txt document);  if you prefer, you may provide all of the 
registration information in a separate letter or purchase order.

PROGRAM DISTRIBUTION

While registered copies of Reveille and Reveille Timer may NOT be used by any other than
the registered individual or institution, any person is permitted (and, in fact, encouraged) 
to distribute the UNregistered, "shareware" versions of Reveille and Reveille Timer to 
others, as long as ALL of their files (specifically including the register.wri file) are 
distributed together (preferably bundled in the rvle-10.zip form).

THANK-YOU FOR TRYING OUT REVEILLE !!!


